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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in February 2024

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Index Name IndexName _
CSI 300 Index +9.4%
HS Mainland
Banks Index 6.7% ]
% Change % Change

Equity Index Futures Access Codes
Vendor HS Mainland Banks CES 120 HSI HSCEI
Bloomberg BMWA CESA HIA HCA
Refinitiv O0#HMBI: O0#HCHH: O#HSI: O#HCEL:
WIND MBIF CHHF HSIF HHIF
ET Net MBI CHH HSI HHI

Data Source: Bloomberg
As at 29 February 2024

Information for reference only
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Equity Index Futures & Options

Hang Seng Index (HSI) Futures & Options

HSI Products

(2024 vs 2023)

HSI Futures

Mini-HSI Futures

HSI Options

Mini-HSI Options

HSI Futures
Options

HSI Volatility
Index Futures

HSI Dividend
Point Index
Futures

Data Source: HKEX

152,347 (+10%)

97,672 (+8%)

24,562 (+8%)

18,470 (+48%)

4,483 (+28%)

0()

15 (-66%)

* Ol compared to previous year-end
Information for reference onlv

As at 29 February 2024

X

136,798 (-3%)

18,908 (+12%)

96,108 (+24%)

35,518 (+75%)

60,120 (+33%)

0()

578 (+37%)

HSI Futures (YoY)

Av erage Daily Volume
(No. of Contracts)

280,000 - mwmmm ADV (L-Axis)
240,000 - Open Interest (R-Axis)

200,000 -
160,000 - \/ NN
120,000 -

80,000 -
40,000 -

Open Interest
(No. of Contracts)

1

- 150,000

- 100,000

- 50,000

HSI Futures (MoM)

Av erage Daily Volume
(No. of Contracts) . (
200,000 - = ADV (L-Axis)

Open Interest (R-AXxis)
150,000 -
a1l
100,000 -
50,000 -
0 s

Open Interest
No. of Contracts)

- 150,000
- 100,000
- 50,000

-0

HSI Options (YoY)

Open Interest
(No. of Contracts)

Av erage Daily Volume
(No. of Contracts)

) 1 ADV (L-Axis) - 400,000
OpenInterest (R-Axis)
45,000 - - 300,000
30,000 - - 200,000
15,000 - - 100,000
0 L e e e e e L 0
Vo> 0 2 O gV X
S S S B S

HSI Options (MoM)

Open Interest
(No. of Contracts)
ADV (L-Axis) - 150,000
Open Interest (R-Axis)

Av erage Daily Volume
(No. of Contracts)

30,000 -

20,000 - - 100,000
10,000 - - 50,000
0 - 0

S 52ES5220 2 Qs
£2833338283¢
2023 |2024



Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level HSI & Top 5 Constituents

. Includes the largest and most ('000)
Index Description o ) ) 30
liquid stocks listed in Hong Kong 19 - HSI VHSI - 28 130 4 HSI Index Tencent
Index Level 16,511.44 (As at 29 Feb 2024) HSBC —AIA
18 26 120 { ——CCB Baba
Index Volatility (30-Day Historical) | 27.0
17 - 110 -
Index Avg. Day High-Low Range 308.39 (Feb 2024) L o4
. 16 - 100 -
HSCE! Correlation (2024) 0.99
15 - 22 g0 -
Hang Seng Index Futures 14 ; ; 20 80
Dec-23 Jan-24  Feb-24 Dec-23 Jan-24 Feb-24
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.83Mn (As at 29 Feb 2024) Distribution of HSI Index Options Ol in Month-end
Call Put
Transaction Cost*
310 5310
= o
Stamp Duty N/A § : <]
~ ()
Trading Fee HK$10 / contract 3 4.0 &3 24.0
a o )
4
SFC Levy HK$0.54 / contract %’ %
2] X 17.0
Commission Rate Negotiable 5 170 S
© =
£
Margin as of 28 Feb 2024 HK$54,200 100 | . . . . . . 100 . . . .
0O 1 2 3 4 5 6 0 1 2 3 4
Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 29 February 2024
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Equity Index Futures & Options

Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Products

HSCEI Futures (YoY)
ADV ol* _
Av erage Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)

HSCEI Options (YoY)

(2024 VS 2023) Av erage Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)
240,000 - == ADV (L-Axis) - 700,000 120,000 + ADV (L-Axis) - 2,800,000
Open Interest (R-Axis) Open Interest (R-AXis)
i - 600,000 i - 2,400,000
HSCEI Futures 213,203 (+14%) 542,211 (0%) 200000 00000 100,000 - 500,000
160,000 o 80,000 - [ e
- 400,000 - 1,600,000
120,000 - 60,000 -
- 300,000 - 1,200,000
Mini HSCEI 80,000 - 40,000 -
Eut SC 10,151 (+5%) 4,300 (-8%) - 200,000 - 800,000
utures 40,000 - - 100,000 20,000 - - 400,000
0 - 0 o+ + 11 5150
b > 0 O QO o
N & X0 N0 9P gb o
S S S $ES S S S

HSCEI Options

35,430 (-12%)

998,071 (+24%)
HSCEI Options (MoM)

HSCEI Futures (MoM)

Av erage Daily Volume

Open Interest

Av erage Daily Volume

Open Interest

Mini HSCEl 5,157 (+51%) 33,778 (+331%) (No-of Comaets) (No-of Contracs) (oo Corree (o ef Comacts)
Options 275,000 | s ADV (L-AxiS) - 800,000 80,000 - ADV (L-Axis) - 2,000,000
Open Interest (R-Axis) Open Interest (R-AXis)
HSCEI Fut 2200001 I g 600,000 60,000 - - 1,500,000
utures
Onti 43,999 (+28%) 934,494 (+37%) 165,000 -
ptions - 400,000 40,000 - ~ 1,000,000
110,000
HSCEI Dividend 55,000 - - 200,000 20,000 - - 500,000
Point Index 480 (-39%) 20,411 (+69%)
Futures L — o © 0 0
S6mSES 2203 3S oo - -
228333582858 228535583858
2023 2024 2023 024

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 29 February 2024
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI

. Comprises the largest and
Index Description p. ] 9
most liquid H shares 114
eS| em—HSCEI
Index Level 5,677.88 (As at 29 Feb 2024) 112 1
110 -+
Index Volatility (30-Day Historical) | 30.6 108
Index Avg. Day High-Low Range 124.21 (Feb 2024) 106 A
Correlation with HSI, CES120 (2024)| 0.99,0.949 104 1
S 102 -
Correlation with CSI300, FTSE A50 0.775.0.708 100 -
(2024)
98 T T T T
1-Feb 8-Feb 15-Feb 22-Feb 29-Fet

Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.28Mn (As at 29 Feb 2024) Call
14.0
. =)
Transaction Cost* g 120
®© 100
Stamp Duty N/A L
& g0
s &
Trading Fee HK$3.5 / contract =
& 6.0
SFC Levy HK$0.54 / contract § 4.0
<
Commission Rate Negotiable 20 | T T . . S
0 10 20 30 40 50
Margin as of 28 Feb 2024 HK$21,500 Open Interest (‘000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 29 February 2024

X

HSCEI & Top 5 Constituents

130 -

e HSCEI China Mobile
Tencent — CCB
Meituan Baba
110 A
90 /F \
70 -
50
Dec-23 Jan-24 Feb-24

Distribution of HSCEI Index Options Ol in Month-end

Put

20 40 60
Open Interest ('000)



Weekly HSI & HSCEI Options Performance
Weekly HSI Options

o Vol
Contract Multiplier HK$50 (,\‘,’o‘_‘g‘f@mraﬂs)
Liquidity Providers Eclipse, I-Access, IMC, Maven, Optiver 40.000 - ® Weekly HSI Options
35,000 - m Weekly HSCEI Options
Transaction Cost* 30,000
25,000
Stamp Duty N/A 20,000
Trading Fee HK$10 / contract 15,000
10,000
SFC Levy HK$0.54 / contract 5,000
Commission Rate Negotiable 0 NN adaoaoadadoaadadaddodNNNNNS
TN O R DO IT DO PDO IND O N B O
= " " 4 N N AN NN N N NN N
i Volume
Weekly HSCEI Options e contracts) |
Contract Multiplier HK$50 20,000 - ==\ eekly HS| & HSCEI Options Call
L . . . e\ eekly HSI & HSCEI Opti Put
Liquidity Providers Eclipse, I-Access, IMC, Maven, Optiver 16.000 - eexty ptions Fu
. 12,000 -
Transaction Cost*
8,000 -
Stamp Duty N/A
. 4,000 -
Trading Fee HK$3.5 / contract
0 T T T T T T T T T T T T T T T T T T
SFC Levy HK$0.54 / contract N N N NN NN
TP ORI IWODDS N MO N B O
Commission Rate Negotiable o H NN NN NN N A

An investment tool to manage short term event risk

Data Source: HKEX
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 29 February 2024
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2024 vs 2023) _— No. of Single Stock Derivatives

Stock Futures 7,525 (+16%)

Stock Options 646,263 (+7%)

Stock Futures (YoY)

Av erage Daily Volume
(No. of Contracts)

Stock Options (YoY)

Av erage Daily Volume
(No. of Contracts)

Open Interest
(No. of Contracts)

Open Interest
(No. of Contracts)

12,000 + mmm ADV (L-Axis) - 40,000 800,000 - ADV (L-Axis) ~ 12,000,000
10,000 - Open Interest (R-Axis) Open Interest (R-Axis)/ | 10,000,000
- 30,000 600,000 -

8,000 - ~ 8,000,000
6,000 - - 20,000 400,000 - - 6,000,000

4 ~ 4,000,000
4000 L 10,000 200,000 -
2,000 - ' - 2,000,000
0 0 T T T T T T T T T T T T 0
N o 2 D gV
S S S S

Stock Futures (MoM)

Av erage Daily Volume
(No. of Contracts)

Stock Options (MoM)

Av erage Daily Volume
(No. of Contracts)

Open Interest
(No. of Contracts)

Open Interest
(No. of Contracts)

s ADV (L-Axis) ) 800,000 - ADV (L-Axis) - 12,000,000
10,000 Open Interest (R-Axis) 40,000 W
8,000 - i 600,000 -
J . 30000 : - 8,000,000
6,000
- 20,000 400,000 -
4,000 - 200000 - 4,000,000
2,000 - - 10,000 :
O 1 B O 0 > > O 0
= >c=oah > ol T5g53280 S
28533885858 £223°286248¢8
2023 2024 2023 2021

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 29 February 2024

X

30,364 (+25%) Single Stock Futures
10,851,792 (+22%) Single Stock Options

Latest and Future Developments

126

Stock Futures

* Products
> 3 A-shares ETFs futures contracts
» Total 98 stock futures contracts

Stock Options

* Products
» 3 A-shares ETFs options contracts
» Total 126 stock options contracts

+ Market Makers (MMs)
» 3 types of market makers (PMM/ CQMM/
QRMM)
» CQMM to provide 50 series continuous
guotations



Hang Seng TECH Index Futures, Options and Futures Options Performance

Hang Seng TECH Index Open Interest (as of 29 February 2024)

- Tracks the largest technology companies
Index Description . .
listed in Hong Kong

Hang Seng TECH Index Futures & Options & Futures Options
HK$50 per index point

HK$172K (As at 29 February 2024)
N/A

Contract Multiplier

Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*

Stam p Duty N/A
Trading Fee HK$5.00 / contract
SFC Levy HK$0.54 / contract

Providing investors with a tool to manage their risk exposure
to Hong Kong-listed technology companies

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 29 February 2024

Open Interest

(No. of Contracts)

500,000
400,000
300,000
200,000
100,000

0

o

— — > c = (@) o = > (S} C o]

T & ] [3)

s < £ 3> 2 8§ 0o 2 AalS ¢
2023 | 2024 |

Average Daily Volume (as of February 2024)

ADV

(No. of Contracts)

150,000 -

100,000 -

50,000 -

0 -

=
=

2023

Volume and Open Interest continue to growth

10



MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Average Daily Volume (as of February 2024)

L Balanced representation from 11 sectors
Index Description

of top 50 China A shares ADV
Index Level 1,853.01 (As at 29 February 2024) (No. of Contracts)
25,000 -
Index Volatility (30-Day Historical) | 21.0 20.000
Index Avg. Day High-Low Range 25.56 (February 2024) 15,000
CSI300 Correlation (2024) 0.958 10,000
FTSEA50 Correlation (2024) 0.968 5,000
0
MSCI China A 50 Connect Index Futures
Contract Multiplier US$25 2023 | 2024 |
Notional Value (1 Contract) US$0.05Mn (As at 29 February 2024) Open Interest (as of 29 February 2024)
Average Quote Size US$0.23Mn (5 Contracts)
Open Interest
(No. of Contracts)
25,000 -
Transaction Cost*
Stamp Duty N/A 20,000 -
Trading Fee US$0.5 / contract
15,000 - N\
SFC Levy US$0.07 / contract
Margin as of 28 Feb 2024 US$2,410 10,000 T—/—— - — - - o -
«c 5 T 5§ 3 88 & 2 3 2/ & o
=S < s 5  n © zZz Aal»> L
2023 | 2024 |
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 29 February 2024



MSCI Asia and Emerging Market Index Futures Performance

MSCI Asia and Emerging Market Index

Index Description

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*
Stam p Duty

Trading Fee

SFC Levy

Average US$40
Average US$48K (As at 29 February 2024)
12

N/A
US$0.6-US$1.0 / contract
US$0.07 / contract

HKEX with the broadest suite of MSCI derivatives products
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 29 February 2024

Open Interest (As of 29 February 2024)

Open Interest
(No. of Contracts)

110,000 -+
100,000 -
90,000 -
80,000 -
70,000 -
60,000
= s > 5 o o B > O c Q
© Q. > [&]
<23~ 290243 5¢E
2023 | 2024 |
Average Daily Volume (As of February 2024)
ADV
(No. of Contracts)
40,000 -
30,000
20,000
10,000
O —
g 3
2023 | 2024 |

Volume and Open Interest continue to growth

12



MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2024)

HSCEI Correlation (2024)

MSCI AxJ Futures

representation 2 DM countries (excl. Japan)
and 9 EM countries in Asia

515.79 (As at 29 February 2024)
11.6

3.88 (February 2024)

0.867

0.837

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

US$100

US$52K (As at 29 February 2024)
US$0.26Mn (5 Contracts)

1.0 index points (February 2024)

Flow and 11 banks

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 28 Feb 2024

N/A
US$0.5 / contract
US$0.07 / contract

US$1,900

Futures contracts have relatively lower transaction costs

Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference onlv

As at 29 February 2024

Open Interest (29 February 2024)

Open Interest
(No. of Contracts)

1,200 -
1,000 -
800 -
600 -
400 -
200 -
0

Apr
May
Jun

Jul

u

Sep
Oct
Nov
Dec
Jan
Feb

Mar

2023

| 2024 |

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

MSCIAXJ e MSCI China MSCI HK
130 MSCISG e MSClIndia o MSCI Indonesia
------------- MSCI Korea weeeeeeee MSCI Malaysia MSCI Pakistan

120 | e MSCI Philippines - MSCI Taiwan MSCI Thailand
110
100

90 -~

80 T T )

Dec-2023 Jan-2024 Feb-2024

MSCI AxJ is a well-established benchmark representing Asia
regional (excluding Japan) equity market performance

13



Hang Seng Mainland Banks Index Futures Performance

5-Min Avg. Bid-Ask Spreads (29 February 2024)

Hang Seng Mainland Banks Index (HSMBI)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2024)

HSCEI Correlation (2024)

10 largest and most representative
HKEX-listed mainland banks stocks

2,511.97 (As at 29 February 2024)
23.7

36.31 (February 2024)

0.922

0.927

Hang Seng Mainland Banks Index Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 28 Feb 2024

HK$50

HK$0.13Mn (As at 29 February 2024)
HK$0.63Mn (5 Contracts)

N/A

N/A

N/A
HK$2 / contract
HK$0.54 / contract

HK$5,860

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 29 February 2024

Minsheng Bank 1988.HK

Bank of China 3988.HK

HSMBI Futures
CEB Bank 6818.HK 0.63%
ABC 1288.HK
PSBC 1658.HK

Bankcomm 3328.HK
CITIC Bank 998.HK
ICBC 1398.HK

CM Bank 3968.HK
CCB 939.HK

Index & Constituents 3-Month Performance (Rebased to 100)

120

115

110

105

100

95

90

Dec-2023

——HSMBI
ICBC (1398.HK)

——CCB (939.HK)
BOC (3988.HK)

. ——ABC (1288.HK)

Jan-2024 Feb-2024

HSMBI Futures can be used for hedging

14



CES120 Index Futures Performance

CES120 Index 5-Min Avg. Bid-Ask Spreads (29 February 2024)

80 A-Shares and 40 HK-listed Mainland
China H-shares, P-chips, and red chips

Index Description

CES120 Futures | N/A
Index Level 4,968.53 (As at 29 February 2024)

Index Volatility (30-Day Historical) | 21.2

Index Avg. Day High-Low Range 75.74 (February 2024)

CSI300 Correlation (2024) 0.901
xistares a0 7 23 [ -

FTSE A50 Correlation (2024) 0.874

i 0,
p— ChinaAVC CSI300 ETF (316814 _ 015
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.25Mn (As at 29 February 2024)
Average Quote Size HK$1.24Mn (5 Contracts) CES120 & Top Constituents’ 3-Month Performance

Rebased to 100

Average Bid-Ask Trading Spread| N/A

120 1——CES120 Index Tencent CCB
Liquidity Providers N/A Ping An - China Mobile
110 -
Transaction Cost* 100 -
Stamp Duty N/A 90 -
Trading Fee HK$5 / contract
80 -
SFC Levy HK$0.54 / contract
: 70 . .
Margin as of 28 Feb 2024 HK$11,600 Dec-2023 Jan-2024 Feb-2024
Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 29 February 2024



Flagship Futures - Contract Specifications

Hang Seng China Enterprises Index

Hang Seng Index Futures Hang Seng TECH Index Futures

Futures

Underlying Index
HKATS Code
Contract Multiplier
Minimum
Fluctuation

Contract Months

Pre-Market
Opening Period

Trading Hours

Last Trading Day

Final Settlement
Price

Exchange Fee

Data Source: HKEX

X

Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
HSI HHI HTI

HK$50 per index point

One index point

Short-dated Futures: Spot, next three

Short-dated Futures: Spot, next three calendar month & next three calendar quarter calendar month & next three calendar
months; quarter months;
Long-dated Futures: The three months of Jun and Dec plus the next three months of Dec Long-dated Futures: The three months of
Jun and Dec

8:45 am - 9:15 am & 12:30 pm - 1:00 pm

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am
(Closed at 4:00 pm on the Last Trading Day)

The second last trading day of the contract month
Average quotations of the underlying index taken at five minute intervals during the Last Trading Day

HK$10.00 HK$3.5 HK$5.00

16



Flagship Options - Contract Specifications

: Hang Seng China Enterprises .
Hang Seng Index Options Index Options Hang Seng TECH Index Options

Underlying Index Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index
Monthly contracts: HSI Monthly contracts: HHI

HKATS Code Weekly contracts: “HSI” + Strike + Month + Weekly contracts: “HHI” + Strike + HTI
Year + “W” + Expiry Day Month + Year + “W” + Expiry Day

Contract Multiplier HK$50 per index point

Minimum Fluctuation One index point

Monthly contracts
Short-dated Options: Spot, next three calendar months & next three calendar
quarter months;
Long-dated Options: the next 3 months of Jun & Dec
and the following 3 Dec months

Monthly contracts
Short-dated Options: Spot, next three
calendar months & next three
calendar quarter months;
Long-dated Options: the next 3 months of

Contract Months /
Contract Weeks

Weekly contracts

Spot Week and the next week, except where the Expiry Day of the Weekly Contract Jun & bec
is the same as the Expiry Day of the Spot Month Contract
Exercise Style European Style
Option Premium Quoted in whole index points
Short-dated Options (monthly and weekly contracts): Long-dated Options (monthly contracts only):
Strike Price = 20,000 200 = 20,000 400
= 5,000 and < 20,000 100 = 5,000 and < 20,000 200
< 5,000 50 < 5,000 100
Trading Hours 9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am (Closed at 4:00 pm on the Expiry Day)

The second last trading day of the contract month (monthly contracts)

Expiry Day The last trading day of the contract week (weekly contracts)

Official Settlement
Price

Exchange Fee HK$10.00 HK$3.50 HK$5.00

Average of quotations of the Index taken at five minute intervals during the Expiry Day

Data Source: HKEX

X .



Flagship Futures Options - Contract Specifications

Hang Seng Index Futures Hang Seng China Enterprises Hang Seng TECH Index Futures
Iltem : . .
Options Index Futures Options Options

Hang Seng China Enterprises Index

Underlying Index Hang Seng Index Futures Hang Seng TECH Index Futures

Futures
HKATS Code PHS PHH PTE
Contract Multiplier HK$50 per index point
Min. Fluctuation One index point
Short-dated Options: Spot, next three
Short-dated Options: Spot, next three calendar months & next three calendar months & next three calendar
Contract Months calendar quarter months and quarter months and
Long-dated Options: the next 3 months of June & December and the Long-dated Options: the next 3 months
following 3 December months of June & December after Short-dated
Options

Exercise Style European Style
Quoted in whole index points

Index points | Strike interval Index points Strike interval

Short-dated Options: Long-dated Options:

Option Premium

Strike Price > 20,000 200 > 20,000 400
> 5,000 and < 20,000 100 > 5,000 and < 20,000 200
< 5,000 50 < 5,000 100

9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am

Trading Hours

Expiry Day
Settlement on
Exercise

Official Settlement
Price

Exchange Fee

Data Source: HKEX

X

(Closed at 4:00 pm on the Expiry Day)
The third Friday of the contract month

Physical delivery on Exercise. All in-the-money options are automatically exercised upon expiry

Average of quotations of the Index Futures Contract of the same contract month,
taken at five second intervals from 3:55 p.m. — 4:00 p.m. on the Expiry Day of the Index Futures Options

HK$10.00 HK$3.5 HK$5.0
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Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information  HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI EM Asia |MSCI EM Asia
: MSCI China [MSCI China NTRJex China NTR  |ex Korea NTR MSCI EM EMEA
Information (USD) Index [Connect (USD) (USD) Index |(USD) Index (USD) Index (USD) Index NTR (USD)
Vendor Futures Index Futures Futures Futures Index Futures
Bloomberg HKCA Index  MCYA Index CSIA Index  CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index
Refinitiv 0#HMAN: 0#HMCA: O#HCHI: O#HCHN: 0#HMAC: 0#HMAK: O#HEAN: O#HMEE:
WIND MANF.HK MCAF.HK EANF.HK

MSCI EM ex
Korea NTR
Information (USD) Index
Vendor Futures
Bloomberg HQIA Index HQYA Index
Refinitiv O#HMXK: O#HMEL:
WIND

. MSCI Japan |[MSCI Japan
Information [NTR (JPY) NTR (USD)
Vendor Index Futures |Index Futures

Bloomberg HQBA Index HJCA Index
Refinitiv 0#HMJJ: 0#HMJU:
WIND MJUF.HK

MSCI
_ Singapore
Information (USD) Index NTR (USD)
Vendor Futures Index Futures
Bloomberg HOBA Index  HKPA Index
Refinitiv O#HMGN: O#HMSN:
WIND

Data Source: HKEX

X

HMPA Index
O#HMEM:

HMOA Index
O#HEMN:

HLCA Index
O#HMHN:

MSCI New
MSCI Malaysia [MSCI Malaysia |Zealand NTR
(USD) Index |NTR (USD) (USD) Index
Futures
HMYA Index  HKEA Index  HOPA Index
0#HMMY: 0#HMMN: O0#HMNZ:
MMNF.HK

MSCI Taiwan
MSCI Taiwan |MSCI Taiwan [25/50 NTR
(USD) Index  [25/50 (USD) (USD) Index
Futures
HJAA Index HRCA Index HRDA Index
O#HMTW: O#HTWP: O#HTWN:
MTWF.HK

MSCI India
NTR (USD)
Index Futures

HJDA Index
O#HMIN:
MINF.HK

HRTA Index
O#HMDA:

MSCI Pacific

ex Japan NTR |[MSCI Pacific
(USD) Index NTR (USD)
Futures Index Futures
HRPA Index HRBA Index
O#HMPJ: O#HMPC:

MSCI Taiwan |MSCI Thailand
NTR (USD) (USD) Index
Index Futures |Futures

HJIBA Index HMTA Index
O#HMWN: O#HMTH:
MWNF.HK

MSCI

Indonesia

Index (USD)

Futures

HMLA Index HKBA Index

O#HMID: O#HMDN:
MDNF.HK

MSCI

Philippines

(USD) Index

Futures Index Futures
HNSA Index HLEA Index
O#HMPH: O#HMPN:

MSCI Thailand |[MSCI Vietnam
NTR (USD) (USD) Index
Index Futures |Futures
HKDA Index HNTA Index
O#HMTN: O#HMVT:
MTNF.HK

MSCI EM ex
China NTR

(USD) Index
Futures

HQDA Index
O#HMXC:

(JPY) Index
Futures

HQAA Index
O#HMJIP:

MSCI
Singapore
Free (SGD)
Index Futures
HKOA Index

0#HMSG:

MSCI Vietham
NTR (USD)
Index Futures

HKSA Index
O#HMVN:
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Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks
Index

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Information Vendor Mainland
Banks Index

East Money HSMBI

Hexin Flush Financial

Pobo Financial

Qianlong 999905

Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
0#HMBI:

Mainland Banks
Index Futures

MBI

MBIC

MBI+Month+Year
209

MBIF+yymm+HK
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. } CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X
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